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© Cypress Semiconductor Corporation, 2011-2012. The information contained herein is subject to change without notice.
Cypress Semiconductor Corporation assumes no responsibility for the use of any circuitry other than circuitry embodied in a
Cypress product. Nor does it convey or imply any license under patent or other rights. Cypress products are not warranted
nor intended to be used for medical, life support, life saving, critical control or safety applications, unless pursuant to an
express written agreement with Cypress. Furthermore, Cypress does not authorize its products for use as critical components
in life-support systems where a malfunction or failure may reasonably be expected to result in significant injury to the user.
The inclusion of Cypress products in life-support systems application implies that the manufacturer assumes all risk of such
use and in doing so indemnifies Cypress against all charges.

Any Source Code (software and/or firmware) is owned by Cypress Semiconductor Corporation (Cypress) and is protected by
and subject to worldwide patent protection (United States and foreign), United States copyright laws and international treaty
provisions. Cypress hereby grants to licensee a personal, non-exclusive, non-transferable license to copy, use, modify, create
derivative works of, and compile the Cypress Source Code and derivative works for the sole purpose of creating custom soft-
ware and or firmware in support of licensee product to be used only in conjunction with a Cypress integrated circuit as speci-
fied in the applicable agreement. Any reproduction, modification, translation, compilation, or representation of this Source
Code except as specified above is prohibited without the express written permission of Cypress.

Disclaimer: CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THIS MATE-
RIAL, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. Cypress reserves the right to make changes without further notice to the materials described
herein. Cypress does not assume any liability arising out of the application or use of any product or circuit described herein.
Cypress does not authorize its products for use as critical components in life-support systems where a malfunction or failure
may reasonably be expected to result in significant injury to the user. The inclusion of Cypress’ product in a life-support sys-
tems application implies that the manufacturer assumes all risk of such use and in doing so indemnifies Cypress against all
charges.

Use may be limited by and subject to the applicable Cypress software license agreement.

PSoC Designer and CapSense Express are trademarks and PSoC and CapSense are registered trademarks of Cypress
Semiconductor Corp. All other trademarks or registered trademarks referenced herein are property of the respective corpora-
tions.
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1.1 Overview

The CY3218-CAPEXP1 CapSense® Express™ Evaluation Kit is used to evaluate the CapSense
Express device. This kit demonstrates the following features: CapSense buttons, LED drive, digital
input, and 12C. The CapSense Express device is configured via a system-level project in PSoC®
Designer™. A 16-pin QFN CY8C20110 device is mounted on the board. The board is powered with
a AAA battery. A boost converter converts the input, in the range of 1.1V to 1.5V, to the device
operating voltage of 3.3 V. The board can also be powered using the CY3240-12USB bridge con-
nected to the 12C header.

1.2 Kit Contents

The CY3218-CAPEXP1 CapSense Express Evaluation Kit includes:
m CY3218-CAPEXP1 CapSense Express Evaluation Board
m USB A to Mini-B cable

m AAA battery

1 mm acrylic overlay

Quick Start Guide

Kit CD, which includes

PSoC Designer IDE

Bridge Control Panel software

CapSense Express datasheets

Kit release notes

Kit user guide

Software release notes

Code example documentation

Hardware design files

Sample silicon CY8C20110-LDX2I (5 numbers)

o o o o o o o o g

1.3 Default Jumper Settings
Jumper (J2) on the CY3218-CAPEXP1 CapSense Express Evaluation Kit board configures the
power setting for the board.

m Default position for J2: Jumper on pin 1 and 2; this enables powering the board via the CY3240-
I2USB bridge.

m To power the board via battery, remove the jumper at J2.

CY3218-CAPEXP1 CapSense Express Evaluation Kit Guide, Doc. # 001-54702 Rev. *B 5
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Additional Resources

Visit http://www.cypress.com for additional learning resources in the form of datasheets, technical

reference manual, and application notes.
m Getting Started with CapSense

This guide is an ideal starting point for those new to capacitive touch sensing (CapSense) as well

as for learning key design considerations and layout best practices to ensure design success.

Document Revision History

Table 1-1. Revision History

PDF Origin
Revision Creation of Description of Change
Date Change
* 03/08/2011 RKPM | New kit guide for CapSense Express
Updated the Install Software section. Updated Figure 2-1. Added content
*
A 12/01/2011 SRVS in the Hardware section. Updated schematics, board layout, and BOM
Updated chapter 4. Modified installation instructions in section 3.2.2.
*
B 05/17/2012 SASH Minor updates throughout the guide

Documentation Conventions

Table 1-2. Document Conventions for Guides

Convention

Usage

Courier New

Displays file locations, user entered text, and source code:
C:\ ...cd\icc\

Italics

Displays file names and reference documentation:
Read about the sourcefile.hex file in the PSoC Designer User Guide.

[Bracketed, Bold]

Displays keyboard commands in procedures:
[Enter] or [Ctrl] [C]

File > Open

Represents menu paths:
File > Open > New Project

Bold

Displays commands, menu paths, and icon names in procedures:
Click the File icon and then click Open.

Times New Roman

Displays an equation:
2+2=4

Text in gray boxes

Describes cautions or unique functionality of the product.

CY3218-CAPEXP1 CapSense Express Evaluation Kit Guide, Doc. # 001-54702 Rev. *B



http://www.cypress.com
http://www.cypress.com/?rID=48787

2. Getting Started

=-='_r__ffj";£
==/ CYPRESS
PERFORM
2.1 Hardware
The following figure illustrates the CY3218-CAPEXP1 CapSense Express Evaluation Kit board fea-
tures.
Top View Bottom View

Status LEDs AAA Battery Holder (J1)

Backlighting LEDs"'

12C Header (J5)

Mechanical Button Power LED CapSense Express

CapSense Buttons Power Selection Jumper (J2)

Figure 2-1 shows the block diagram of the CY3218-CAPEXP1 CapSense Express Evaluation Kit.
The block diagram has two main sections, power supply and CapSense controller. The power supply
section is based on the onboard battery power. The 1.5 V battery voltage is converted into 3.3 V with
boost converter because the CapSense controller does not work below 2.4 V. The connector J2 pro-
vides an option to power the kit from the onboard battery or an external power source, which must
be connected to the J5 connector. An LED indicates the power status of the kit.

The status on touching the three CapSense buttons is indicated using the three LEDs connected to
the GPIOs of CapSense Express. A mechanical switch, which demonstrates the capability of
CapSense Express to read the status of external digital signals, is also provided with the kit. The
CapSense Express controller can be configured and controlled through the 12C interface; therefore,
a 5-pin header is provided for the 12C interface.

CY3218-CAPEXP1 CapSense Express Evaluation Kit Guide, Doc. # 001-54702 Rev. *B 7
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Figure 2-1. CY3218-CAPEXP1 CapSense Express Evaluation Kit Block Diagram
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The CY8C20110 chip is a low-power CapSense Express Controller, which can be powered from a
single 1.5 V AAA battery. The CapSense Express controller can work only from 2.4 V to 5.5 V power

supply; therefore, a boost converter is used in the kit to generate the 3.3 V power supply required
from the 1.5V battery.

Figure 2-2. Power Supply System
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The jumper J2 provides power on/off control for the kit. When the jumper is inserted, the Enable
Input (EN) pin of the boost converter is connected to ground, which cuts off power to the kit. Remov-

ing the jumper J2 connects the EN pin to VDD, to power the kit. The LED turns on when the kit is
powered.
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2.1.2 Mechanical and CapSense Buttons

Figure 2-3. Input Schematic (CapSense Button and Mechanical Button)
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Figure 2-4. LED Schematic
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2.1.3 CapSense Controller

The CapSense Express controller chip is connected to two input sections and two output sections.
The CapSense rectangular button and mechanical button provides input to the chip. The output is
provided through the status LEDs and backlighting LEDs, which turn green. The mechanical button
provides the signal with mechanical on/off, similar to the CapSense rectangular button.

CY3218-CAPEXP1 CapSense Express Evaluation Kit Guide, Doc. # 001-54702 Rev. *B 9
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Figure 2-5. CapSense Controller Schematic
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2.1.4 12C Interface

The CY3218-CAPEXP1 CapSense Express Evaluation Kit has the 5-pin header J5 for 12C interface.
The 12C interface is used to connect the CapSense controller with the host system to monitor the
sensor status and configure the CapSense controller according to system requirements. The sensor
is also tuned during the design stage using the 12C interface and the CY3240-12USB Bridge tool.

I12C communication needs pull-up resistors, both SCL and SDA signals, on the master or slave side.
The kit hardware has footprints R13 and R15 (no-load components by default) to populate pull-up
resistors if they are not available on the master side.

The CapSense Express controller supports 50 kHz, 100 kHz, and 400 kHz data transfer speed for
the 12C interface.

Figure 2-6. 12C Interface Schematic
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3.1 Install Hardware

CAUTION Make sure you do not touch the board anywhere other than the edges or on the buttons.
Touching the board in the wrong area can lead to a short and an unresponsive board. If this hap-
pens, reset power to the board. To do this, disconnect the battery supply by placing the jumper on
J2. To power the board again, remove the jumper from J2.

The CY3218-CAPEXP1 CapSense Express Evaluation Kit is preprogrammed with demonstration
firmware. These instructions assume that your board is not reconfigured from the factory settings. If
it has, follow the instructions given in Create Project with CY3218-CAPEXP1 chapter on page 23 to
configure the board.

1. Unpack the CY3218-CAPEXP1 CapSense Express Evaluation Kit.
2. Insert the AAA battery into the battery holder.

3. Remove the jumper from J2 (back, left, and center of board). The red LED, D1, on the back of the
board lights up.

4. Touch a button on the board. The LED in the center of the button and the LED above the button
lights up.

5. Press the mechanical button at the bottom of the board; the three LEDs above the buttons turn
on.

6. Turn the board off by replacing the jumper on J2. Note that replacing the jumper disables battery
operation.

3.2 Install Software

Install the software required to load and run the code examples.

3.2.1 Before You Begin
All Cypress software installations require administrator privileges, but this is not required to run the
installed software.
1. Shut down all Cypress software that is currently running.
2. Disconnect ICE-Cube or MiniProgl devices from your computer.

Note that CapSense Express runs on an older version of PSoC Designer (PD5.0). Therefore, both
versions of PSoC Designer are required - PD5.0 for CapSense Express and PD5.1 for all other
devices.

3.2.2 Installing Software

To use the CY3218-CAPEXP1 CapSense Express Evaluation Kit, you need:

m PSoC Designer 5.0 SP6
m PSoC Programmer 3.13.3 or later
m Bridge Control Panel 1.3 or later (packaged with PSoC Programmer)

CY3218-CAPEXP1 CapSense Express Evaluation Kit Guide, Doc. # 001-54702 Rev. *B 11
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If PSoC Designer (versions older than PD5.0 SP6), PSoC Programmer (versions older than
PP3.13.3), and Bridge Control Panel (versions older than BCP1.3) are currently installed, uninstall
the same before reinstalling. To uninstall, go to Start > Control Panel > Add or Remove Programs
and click the Remove button adjacent to the particular software. Follow the instructions to uninstall.

Follow these steps to install the software:

1. Insert the kit CD/DVD into your PC's CD/DVD-ROM drive. Click Install PSoC Programmer
3.13.3... on the installation startup screen.

Elcv3218 - CAPEXPL EVK

=/ CYPRESS

PERFORM

CY3218 - CAPEXP1 EVK

© 2009 Cypress Semiconductor Corperation. All rights reserved

2. Wait for the installer to copy all the necessary files to a temporary folder.

P5oC Programmer Setup Installer, E“:I@

a 7 3
Eutracting  USBBootioader. 1045 mai
ANNENENNENNENENEN

CY3218-CAPEXP1 CapSense Express Evaluation Kit Guide, Doc. # 001-54702 Rev. *B
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Installation

3. Click Next to install in the default location. To select a different location, click the Change button.

P5oC Programmer, - InstallShield Wizard El

Welcome to the InztallShield Wizard for P5SoC
Programmer

The InztallShield \Wizard will inztall PSoC Programmer on
waur computer. To continue, click Mext.

Select falder where zetup will install fles.

G Ingtall PSoC Programmer bo:
C:A MCypress

< Back Mest » l[ Cancel l

4. Wait for the installation to complete.

PSoC Programmer - InstallShield Wizard
Setup Status

The InstallShield Wizard iz instaling PSaC Programmer

[hstalling

Cancel

CY3218-CAPEXP1 CapSense Express Evaluation Kit Guide, Doc. # 001-54702 Rev. *B 13
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5. The Cylnstaller window for PSoC Programmer is displayed when the installer is ready. Select
Typical in the Installation Type options list and click Next to proceed.

* Cylnstaller for, PSoC Programmer

Product Installation Overview
Chooze the install type that best suits pour needs

Chooze the type of installation
Praduct:
PSolC Programmer

Installation Type:

Tupical w

Inztallz the most common features of PSeC
Prograrnmer

The following products need to be inztalled manually
Adobe Reader

o

6. Read the Software License Agreement and select | accept the terms in the license agreement;

click the Next button.

* Cylnstaller for PSoC Programmer,

License Agreement
You muzt read and accept the licenze before you install the software

License Agreement

CYPRESS END USER LICENSE ]
AGREEMENT

PLEASE READ THIS END USER LICENSE AGREEMENT (" Agreement')
CAREFULLY BEFORE DOWNLOQADING, INSTALLING, OR USING THIS
SOFTWARE AND ACCOMPANYING DOCUMENTATION ("Software"). BY
DOWNLOADING, INSTALLING, OR USING THE SOFTWARE, YOU ARE
AGREEING TO BE BOUND BY THIS AGREEMENT. IF YOU DO NOT
AGREE TO ALL OF THE TERMS OF THIS AGREEMENT, PROMPTLY

(%) | accept the terms in license agreement

() | do nat accept the terms in license agreement

<Back ” Mext » l ’ LCancel

CY3218-CAPEXP1 CapSense Express Evaluation Kit Guide, Doc. # 001-54702 Rev. *B
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7. Wait for the installation to complete.

* Cylnstaller for PSoC Programmer,

Installation Page
Flzaze wait while setup inztallz/configures PSoC Programmer on gour complter

Caching L
o PSaCProgrammer3.13.3.1045
@ ClockProgrammer.3.0.1045
o USBE ootloader 1045

o BridgeControlPanel1.3.0.1045 —_—— .
o Evarietode 1005 . =L the inside scoop
o DeviceDatahase. 1045 .- on Cypress products.

Installing
e PSol Programmer 3.13.3 [1045)
Clack Programmer 1.3 [1045]
USE Bootloader Application [1045)
Bridge Contral Panel 1.3 [1045) 3

< = 3 c

Check out Cypress blogoshpere at
www.cypress.com/go/blogs

Statusz

[lllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllllll

8. Click Finish to complete the installation. Select the View Release Notes option to open the
release notes after the installer window closes.

* Cylnstaller for PSoC Programmer,

CY3218-CAPEXP1 CapSense Express Evaluation Kit Guide, Doc. # 001-54702 Rev. *B
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9. Click Install PSoC Designer 5.0... in the installer startup screen.

ECv32186 - CAPEXP1 EVK

S

==/ CYPRESS
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CY3218 - CAPEXP1 EVK

09 Cypress Semiconductor Corporation. All rights reserved

Note If the installer does not start automatically, start it manually by executing cyautorun.exe in
the CD/DVD's root directory.

10.Wait for the installer to copy all the necessary files to a temporary folder.

InstallShield Wizard

a

-

Entracting: PSol Designer 5.0 msi

FSolC Degigner 5.0 Setup iz preparing the InstallShisld Wizard,
which will guide you through the program setup process. Flease
wait,

[(WEER

| | Cancel

CY3218-CAPEXP1 CapSense Express Evaluation Kit Guide, Doc. # 001-54702 Rev. *B
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11. Read the Software License Agreement and select | accept the terms of the license agreement;
click the Next button.

PSoC Designer 5.0 - InstallShield Wizard

License Agreement ==
Pleasze read the following licenze agreement carefully. ;jﬁypﬁhss
CYPRESS EMD USER LICEMSE AGREEMEMNT ~

FLEASE READ THIS END USER LICEMSE AGREEMEMT [“Agreement”] CAREFULLY
BEFORE DOWMLOADING, INSTALLING, OR USING THIS SOFTWARE AMD
ACCOMPANYING DOCUMENTATION S oftware"). BY DOWHLOADING,

INSTALLIMG, OR USING THE SOFT'WARE, Y'OU ARE AGREEING TO BE BOUMD BY
THIS AGREEMENT. [F%'0OU DO MOT AGREE TO ALL OF THE TERMS OF THIS
AGREEMENT, PROMPTLY RETURN AND DO NOT USE THE SOFTWARE. IFvOU
HAWE PURCHASED THE SOFTWARE, wOUR RIGHT TO RETURM THE SOFTWARE
EXPIRES 30 D&YS AFTER vOUR PURCHASE AMD APPLIES ONLY TO THE

ORIGINAL PURCHASER.

W

(#) | accept the terms of the license agreement

()| do not accept the terms of the license agreement

< Back I Mesxt » l[ Cancel ]

12.Click Next to proceed with the Installation.

PSoC Designer, 5.0 - InstallShield Wizard E|
P5SoC Deszigner b

Welcome to the PSoC Designer 5 Setup program. This
pragrarm will inztall PSolC Designer 5 on vour computer.

<Back | Mest> |[ Cancel

CY3218-CAPEXP1 CapSense Express Evaluation Kit Guide, Doc. # 001-54702 Rev. *B 17
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13.Click Next to install in the default location. To customize the install location, click on the Browse
button and navigate to the respective directory.

P5oC Designer. 5.0 - InstallShield Wizard

Chooze Destination Location == —~
Select falder where setup will install files. a? CYPH]:.SS

FPERFORM

wielzome ta the PSoC Designer 5 Setup program. This program will inztall PSeC Designer
5 an your computer.

Destination Folder

C:\Pragram Files\Cypressh,

[ <Back || Memt> |[ Cancel ]

14.Review the settings before starting the installation. Click Back to change the settings, if required.
Otherwise, click Next to start the installation.

PSoC Designer 5.0 - InstallShield Wizard

Start Copying Files

_— ~
Review zettings before copying files. aﬁtYPHhSS

FERFORM

Setup haz enough information bo start copying the program files. If you want o review o
change any settings. click Back. |f you are satisfied with the settings, click Nest ta begin
copying files.

Current Settings:

|stallation Directary: C:\Pragram Files\Cppressh,

<Back || Mewt» |[ Cancel

18 CY3218-CAPEXP1 CapSense Express Evaluation Kit Guide, Doc. # 001-54702 Rev. *B
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15.Wait for the PSoC Designer 5.0 installation to complete.

PSoC Designer 5.0 - InstallShield Wizard [§|

S/ Cvpress

FERFORM

Setup Status

Fleaze wait while PSol Designer 5.0 iz inztalled,

Yalidating install

Cancel

16.Click Yes if you want a shortcut to PSoC Designer on your desktop; click No to continue with the
installation.

Question

\g) WWould vou like to place a PSoC Designer shortcut on the deskiopy

17.Click Finish to complete the installation. Select the View Release Notes option to open the
Release Notes after completing the installation.

PSoC Designer 5.0 - InstallShield Wizard

Install5hield Wizard Complete

YPRESS

FERFOF M Setup has finizhed instaling PSoC Dezigner 5.0 an your
camputer.

< Back Cancel

CY3218-CAPEXP1 CapSense Express Evaluation Kit Guide, Doc. # 001-54702 Rev. *B 19
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3.221 PSoC Designer Overview

PSoC Designer is the revolutionary integrated design environment (IDE) that helps you to customize
PSoC to meet your specific application requirements. PSoC Designer accelerates system bring-up
and time-to-market. Develop your applications using a library of pre-characterized analog and digital
peripherals in a drag-and-drop design environment. Then, customize your design leveraging the
dynamically generated API libraries of code. Finally, debug and test your designs with the integrated
debug environment including in-circuit emulation and standard software debug features.

To open the application, click Start > All Programs > Cypress > PSoC Designer <version>>
PSoC Designer <version>.

For instructions on creating and developing firmware projects for CapSense Controller in PSoC
Designer, see the IDE User Guide.pdf available at the following location:
<Install_directory>:\PSoC Designer\<version>\Documentation\.

20 CY3218-CAPEXP1 CapSense Express Evaluation Kit Guide, Doc. # 001-54702 Rev. *B
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Functional Description

The board consists of three CapSense buttons; it has three status LEDs and three backlight LEDs
associated with these CapSense buttons. The status LEDs light up when the CapSense buttons are
touched. The backlight LEDs are initially lit 5 percent and glow to full brightness when the CapSense
buttons are touched.

The completed project is available in <CD_root>:\Program\ThreeCapSenseButtons\.

The CY3240-12USB Bridge is used to transfer the configurations done in PSoC Designer to the
PSoC device on the board. The CY8C20110 device used in this kit is an I2C communication enabled
device for CapSense configuration, reading the status and data registers of the device, and so on.
See the device datasheet for more details.

The 12USB Bridge is used to monitor and tune the CapSense parameters; these parameters can be
transferred to the device from the GUI through the I2USB Bridge without reprogramming the device.

Create New Project

1. Connect your computer to the CapSense test board I12C connector (J5) using the CY3240-12USB
Bridge and a USB cable, as shown in this figure.

Mini USB Port

Front of Board

"@mﬂ;;}

R,
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Ensure that the jumper J2 at the back of the board is open and the red LED, D1, is ON.
Launch PSoC Designer.
To create a new project, click on File > New Project.

Select the System-level Project icon in Project types; name the project ‘ThreeCapSenseBut-
tons’ and save it to a location of your choice.

a s~ wbn

Mew Project E|®

Project types:

Y
Chip-level
Project

E-This beginz with a classic P5oC Express v3.0 ploia that alzo supports selecting and placing user modules. 1

Hame: | Threelap% enseButtans
Location: | CAmyPrajects\CAPEXFT Example Project SFVS [ Browse..
‘Wirkspace name: ::fhreel:apSense:I::!uttons ! Create directomn for workzpace

[ ak. l [ LCancel l

6. Select View > All Driver Catalogs and then select the Inputs tab, as shown in the figure. Open
CapSense Express > CY8C20110, right-click the 10 GPIO/CS Button Set driver, and select
Add to Design. The Add Input Driver window opens.

Inputs -~ I
== CapSense Express -~
[ CvBC22030-16 OFM - 4 Inputs +
[ CYBC22140-24 OFM - 7 Inputs +
[ CYBC22200-32 QFM - 10 lnputs -
[ CvBCZ22240-48 OFM - 12 lnputs -
[ CvBC22300-42 AFM - 15 lnputs -
[ CYBC220A0-16 OFM - 8 Inputs £
[ CvBCZ22140-24 GFM - 15 Inputs
[ CYBC22240-32 OFM - 23 Inputs
[ CYBC223A0-48 OFM - 31 Inputs

[ Cvaczolan
[ Cvaczo111
[ Cvaczoz
[ Cvaczo140
[ Cvaczol42
[ Cveczolen
[ Cvaczoa0
== CvBeC20110
&= 10 GPIO/CS Button Set -
< >

IInputs IOutputs Valuators Interfa... User M...
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7. Name the driver ThreeButtons and click OK. The CapSense Express 10 GPIO/CS Button Set

8.

window opens.

“ Add Input Driver,

Bame: 10 GPIO/CS Button Set 1.1
|ThreeEuttons{ | thiz Certified Cypress Driver haz been
modified.
Deszcription:
.Y
10 GPIO/CS Button Set
Functional Description
Driver Properties
Driver Specifications
Interface Schematic
Functional Description
Use this driver with CY8C20110 devices for more
information refer to the datasheet This is a set of general-
purpose input/output with configurable drive mode. When
calartad and nlarad in dacian thic Arivar nrovidae 10 ¥
Froperties:
.
W
Property Editor
Activates Property Editar
[] Do not show this dialog [ ok l [ LCancel ]

In the system-level project, each CapSense button, LED, and the mechanical button require a

Create Project with CY3218-CAPEXP1

separate driver. The ‘10 GPIO/CS Button’ driver is a special driver that allows you to configure all

the buttons, LEDs, and the mechanical button in one interface. Based on the 1/O requirements,

drivers are available in the driver catalog.

CY3218-CAPEXP1 CapSense Express Evaluation Kit Guide, Doc. # 001-54702 Rev. *B
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CapSense Express 10 GPIO / C5 BUTTON SET : ThreeButtons * WARNING! You must apply to board to abserve chan... [ |[X]

| Parameters

= 1} U 8] U U U u u ) U

5 co (] c2 c3 C4 C5 & 7 ca c3
Fin Type iEapsm: e | Capser: W | Capsens v | Capten: w | Capsem | » Il:apsen: v | Capsen: |I3apsen: v | Capzen: » | Capsens v
Irvversion iNu Vl_No _vJNo vINo V|No v]Ho leo V_lNa v[_No V|_No v
Irtemapt
LatchDiscben | Fising % |Risng |v||Rising | Rising |+ | Riting || Riing ¥ [Rising |+ | Rising v |Fiising % [Rising |
Diive Mode : Fesis ] =i sihny il ish ! f
FingerThieshold 100 2100 2[00 zfto0  g[o0 &[0 Zfieo ghon g0 ffio 2
pree-t | (CRE O (K K O C (O | O (O
GPIO Output

Pin Specific Tuning Configure Global Parameters

Select Fin v (@1 |

Emtemnal Capacho Dizable ~
Hypsteresiz 10
Low baselins reset 20
Meqgative noise theeshald | 200
Meize Thieshold 40
Senzor futo Reset Dizable
Settling time 160

B Global Parameters
12C Addiess a
|2C pin divve mode Open Drain Low
\fokage 33

E PWM Specific
Apply Delay To P output
Nil=u_ms 0 b

Apply Delay To
Apply Delay b the P outpid or the Logic Level output.

[ o« ]| seobroboad || concel |

| Esport Report |[ Reset J
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4.3 Configure the Driver

By default, all I/Os in the Configure Local Parameters pane are set to CapSense Input. To set up
backlight LEDs with PWM, set the Pin Type for C3 through C5 to PWM and the Drive Mode to
Strong Drive. Similarly, to set up status LEDSs, set the Pin Type for C6 through C8 to GPOutput and
the Drive Mode to Strong Drive. For the mechanical button, set C9 to GPInput and set the Drive
Mode to Resistive Pull Up and Inversion to Yes. Set the Finger Threshold of CO through C2
CapSense inputs to 150.

GFO[2] GP1[4) GP1[3] e} GP[1] GPO[] GROO] GRO[3] GP1[2] GPO[4]

Fin Aszignment

[E-FNI co (o] 2 G3 G4 G5 Gb 67 GB 69
Piri Type Capser Il:apsens v | Capser: » iF"w’M v Pw I P v ! GFOulp » | GFOwp » | GFOutp » |I3F'Input w
Ivversion Mo wfNo  wNo  w[No  w[No  wNo  wlNo  w[No  w|Mo  wfres v
Interrupt OFF ~|OFF  ~|OFF (v |OFF ~|OFF ~|OFF  |w|OFF  |v

Latch Direction Rising  + IHising b i Rizing % |Rising % |Rising % i Rizng |+ : Rising | Rising % I Rising |+ iHising v

Drive Mode: Strong [ w | Stong [ ! Strong [ ! Strong [ Shong [ » | Strarg [ w i Resistive w

0 & |15D = 150 | | |
14 2|4

o

Firges Theeshald 1

IDAC Sefiings ! | _ | [
GPI0 Output Output L w | Qutput L s | Output L I Oustput L | Dutpust L+ i Output L %

LAY

=

4.4 Configure Button and LED Behavior

1. In the Pin Specific Tuning pane, choose G3 from the Select Pin menu.

Pin Specific Tuning

Select Pin G3 ]

2. Click on the yellow box of the CapSense button you want to assign to LED G3. For LED output
pin G3, select the CapSense button C0. A small line connects CO to the purple OR box. To turn
the LED on when the button is touched, click the small box (highlighted in the following figure) to
the right of the purple OR box.

Pin Specific Tuning |

Select Pin G3 w
Humber of Operands ) One ) Two
Operandl

) Use Latched (%) Use Status

Cl

1
—[ [=

rpl
(== I | I Y I | B2 R PR Y ) (S

l

M

Loy

OR

o |5 [S3] [S

COutput Fin

G G3

w
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This changes the square to an invert symbol; this is needed as the LED is connected in current
sink mode.

Pin Specific Tuning

Select Pin G3 w

Murnber of Operands =) One T

Operandl

3 Use Latched (% Use Status
i

)

Lol L]
| [

C
G

oal [

OR

I
G
G

v

o

T

o
=]

T

Output Pin
G3

G

o

3. Repeat step 2 for all three backlight LEDs G3, G4, and G5, and route them to CapSense buttons
CO, C1, and C2, respectively.

4. The status LEDs turn On only when a mechanical button is touched. To configure this behavior,
select the status LED G6 from the drop-down list and select the CapSense button and the
mechanical button G9 as input to the LED. Click on the square next to purple box and change to
an invert symbol; this is needed as the LED is connected in current sink mode. The pin G6 looks
similar to the following figure when configured.

Pin Specific Tuning

Select Pin GE o

Mumber of Dperands * One ) Twa

Operandl

i Use Latched & Use Status

)

)

L)
=

7
C2

o
(5]

OR

G5

v

oy

Z

ol
[an]

T

Output Pin
Gb

G

w
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tons CO, C1, and C2, respectively.
6. The configuration of all the LEDs appear as follows.
Select Pin G2 i
* Ore ) Two

Mumber of Operands

5. Repeat the same procedure for the status LEDs G6, G7, and G8 with routing to CapSense but-

Dperandl

i Use Latched (8 Use Status

Select Pin G4
) One 2 Two

[ co
OR |
-
Output Pir
[ G8 ] G3
W

MHumber of 0perands

Operandl

=
=

=
o
vl ! @
ra |
o
(v}
=
[}
(=N
=
o
[ ]
o
o
=
o

i

o
v,

1>
Output Pin
[ G5 ] G4
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Pin Specific Tuning

Select Pin G5 ~
Mumber of Operands ) One O Two
Operandl

) Use Latched 0 Use Status

ca
[

[y
Fa| | =

o [a]

OR

e

v

ol =

Output Fin
9 Gh

o

Pin Specific Tuning

Select Pin GE v
Mumber of Operands ) One ) Two
Operandl

) Use Latched & Use Status

)

= Rt

0

(5] I (]

OR

o

v

G7

1] Output Pin
[El=] Gh
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FPin Specific Tuning

Select Pin G7 v
Humber of Operands * Ore ) Two
Operandl

i) Use Latched 5 Use Status

ca
[

)
[ I

OR

Output Pin
G?

[y O ) R Rt} N m ) I ey | I ) (R LR

¥
E]
A
=
o
g,
=
[yl
=
=
=
E]
=]

Select Pin G8

<

Mumber of Operands ) One ) Two

Operandl

) Use Latched %) Use Status

=
el B =]

OR

o (S| (S (S 1S3 || |
= [ e (] o] [P

oo

G Output Fin
G9 G

7. Enable the 12C Drop The Sample filter in the CapSense Filtering Specific section in the Global
Parameters Window.

Configure Global Parameters

o2

E CapS5ense Filtenng Specific
ayeraging Filker Dizable

12C Drop The Sample Enable
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8. Use the default CapSense Global Parameters, as shown in the following figure.

Configure Global Parameters

Ezz | A&
CEM A

E Capsense 5pecific
Bazeline Update Threshe 100

Clock M0/
Debounce 3
Esternal Capacitor Dizable
Hysteresis 10
Low bazeline reset 20
Meagative noize threzhold 20
Moize Threzhold 40
Sensor Auto Reset Dizable
Settling time 160

9. Configure I12C related parameters in Global Parameters, as shown in the following figure.

Configure Global Parameters

El Global Parameters

|2C Addresz 0
|2C pin drive mode Reszistive Pull Up
‘Woltage 33

10.Disable sleep mode in the Sleep Management section because it does not allow CapSense tun-
ing.

El Sleep Management

Sleep Mode Dizable

11. Configure PWM Specific parameters with 90 percent duty cycle, mode to Toggle-FlipFlop and Pin
State to Logic O/PWM.

E PwWM 5pecific

Apply Delay To Foadbd output
Delay, ms I

Duty Cycle, % a0

tode Toggle-FlhpFlop

Fin State 01 Linker Logic 0/ Pl

4.5 Pin Assignment

1. Click the Pin Assignment (16-QFN) button in the top left. The User Pin Assignment window
opens.

Pin Assignment
[16-QFN)
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2. Select 16 pin QFN as the Pin Package Type.

Fin Fackage Type
8 pin S0IC

O 16 pin S0IC

&) 16 pin CFK

Create Project with CY3218-CAPEXP1

3. Assign each CapSense button, LED, and mechanical button on the board to the pin annotated on

the board

GP0.2

GP1.3

4. Drag each driver from the unassigned list to the appropriate pin.

User Pin Assignment

Drag and Drop onto Pins to Assign.

_ [ Buttanl (CO)
(‘;i [ ButenZ(C1]
z 1 Buttend (C2)
=4 o
8 EGE [ Outputl [G3]
Output2 G4
) L| L| L| L| 1 Outpui2 [54)
15 15 14 13 [ Outputd [G5)
ol cysczoi10 12 B L1 Outputd (G6)
G5 2 .. 11 ] XRES [ Outpuis (57)
pin QFN
RCscL [ 3 1w e
=] Outputs [GE)
recsoa [ a o i c2
5 8 7 B / ] Inputl (59)
o @ =
o B @ g-'
e
Pin Pack T
— w _ in Package Type
— Lec ed pins _ ) ) - -
guins0lc O 16pinS0IC & 16 pin GFN
[ Awailable placements :
Auta Azsign
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Driver Pin
Buttonl (CO) GPO[2]
Button2 (C1) GP1[4]
Button3 (C2) GP1[3]
Outputl (G3) GP1[0]
Output2 (G4) GP1[1]
Output3 (G5) GPO[1]
Output4 (G6) GPO[0]
Output5 (G7) GPO[3]
Output6 (G8) GP1[2]

Inputl (G9) GPO[4]

5. Click OK to close the User Pin Assignment window.
6. Click Apply to board.

[ Ok ] [ Apply to board I ’ Cancel ]

| Export Repart | [ Reset ]

7. Wait for the Configure through USB2IIC Bridge status window to appear and click OK.

Configure through USB2IIC Bridge status §|

CapSense Express Part Mumber is: CYSC20110

Unlock I2CDevLockiCkYDDLock register For T2COL - Write successful
Set new [2C address and I2C pins Drive Mode - Write successful
Lock I12CDevLockZIkvDDLock register - Write successful

Mew I2C Address is: 0x00

Send command "enter setup mode” - Write successhul

Disable all GRIOs - Write successful

Send GPIOs settings area - Write successful

Send Qutputs logic levels - Write successful

Send CapSense Output setkings - Write successful

Send CapSense Global parameters - Write successful

Send CapSense sensor parameters - Write successful

Send Sleep Management Parameters - Write successful

Send command "store current config” - Write successful

Send command "reconfigure device" - Write successful

Send command "Set normal operation made” - Write successful

i» CapSense Express found at I2C address: 0x00
T

File with I2C commands for configuration through RAM registers located in

C:iDocuments and SettingsisashiDeskkopiMew FolderiThreeCapSenseButtons! ThreeapSenseButtons_config_through_regs.ic
File with I2C commands Far configuration through Flash located in

C:iDocuments and SettingsisashiDeskkopiMew Folder\ThreeCapSenseButtons! ThreeapSenseButtons_config_through_flash.iic

8. Click OK to close the CapSense Express 10 GPIO/CS Button Set: ThreeButtons window.

4.6 Verify Output
1. Select the I2CUSB bridge power supply option.

'h”? ﬂ (5' || e v|"_'u:|i1.".r;..'t£<-.‘i 3.5 4 |

Board Powered

54 Supplied
3.3 supplied

2. The backlit LEDs are at 5% brightness and the status LEDs are OFF.
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3. Touching the CapSense buttons toggles the LED brightness from 5% to 100%. The correspond-
ing status LED turns ON as long as the finger is present on the CapSense button.

4. The status LEDs associated with CapSense buttons are as follows:

LED CapSense Button
D6 GPO[2]
D7 GP1[3]
D8 GP1[4]

5. Pressing the mechanical switch S1 turns ON all the status LEDs. The status LEDs will be ON as
long as the switch is pressed and turns OFF when switch is released.
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5. Tune CY3218-CAPEXP1

5.1

CY3218-CAPEXP1 CapSense Express Evaluation Kit Guide, Doc. # 001-54702 Rev. *B

Monitor CapSense Signal

Follow these steps to monitor the CapSense signal.
1. Click Monitor to open the Monitor view.

Start Page .~ ThreeCapoe...x [System]*

| 5 Design | g Simulation || % i-| BOM/Schematic |

2. The Monitor Status indicator shows Connected.

Cannected

3. Select the I2CUSB bridge power supply option.

1”> E {!j || '|f_'|:|i1r‘.r;-:te>.ui' 2a 4|

Board Powered

SV Supplied
3.3% Supplied

E

PERFORM

Right-click ThreeButtons and select Show Tuner.

5. The Monitor Status indicator changes to Running and the CapSense Express window opens.

Rurinimg

(o]

. If your board is configured with another design, click Apply to board in the lower right of the

CapSense Express window. When the Configure through USB2IIC Bridge status dialog
appears, click OK. If your board is already configured with the correct design, the Apply to board

button is grayed out.
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5.2 Tune Buttons
1. Select CO from the Select Pin menu.

i in épecific uning

-

2. Touch the CO button (extreme left CapSense button). When the difference variable (represented
as a red vertical bar) is higher than the finger threshold (represented as a dark blue horizontal

bar, set to 150 by default), the touch registers as a hit.

Wariable Watch
Faw Count:  B&0 Statug:

Difference: 243
Bazeline: 407
Statuz 1

[ Force Reset Baselings J

3. Place the overlay provided with the kit on the board (covering all buttons).

4. Reset the device. To do this, click OK to exit the Tuning window and select the powering option
as Board Powered; then choose 3.3 V Supplied again.

5. Notice how the Difference Count value changes. If the difference variable does not rise above the
required finger threshold, the button does not register a hit. The LEDs do not function as
expected.

Wariable Watch
Raw Count: 331 Statug

Difference: 71
Bazeline: 260
Statuz 0

[ Force Reset Bazelines J
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6. Reducing IDAC increases the signal strength and vice versa. To tune this button with overlay,
reduce the IDAC; apply the new setting to the board by hitting the Apply to Board button. Now,
touch the button and check the response; if it does not meet the requirements, repeat the pro-

cess.

Fin Type

Irveersion
Intermipt

Latch Direction
Drive Mode
Finger Threzhold
IDAL Settings
GPFIO Output

GRO[Z] GF1[4]

Ca i

[ 1
| Capsen: » E Capzer: ¥ |

!No V_E_Nn

1
5|

| Rising  » I Rizing

7. Repeat step 1 to step 6 for C1 and C2 CapSense buttons.

8. Test the board by touching the CapSense buttons. The LEDs on board function according to the
design. Also notice how the Pin Status and Latched Value indicators change based on touch.

Fit Type

|nweersion
Intermpt

Latch Direction
Drive Mode
Finger Theeshold
|DAL Settings
GFIO Output

Pir Status
Latched Yalue

GFO[2]
Ca

GP1[4]
C1

GP1[3]
2

GP1[0]
G3

GPI[1]
G4

GPOfT]
G5

U
(EE]

GRO[O]
GE

GRO[3]
GF

GP1[2)
GE

'Ho

vINu VINO

"l

1

ND leo V;Nu VIND VjNu v|

b [Yes

OFF '~ |OFF viUFF w|oFF  w[oFF  w|oFF  wloFF |

Rizng 'VJ Hising VIFhsmg v|

Rizng |» | Fhsmg b J Fh_s_lng w | Rising |+ IFhsmg v ]ngl_rn_t?! [Fhslng ¥ |

exist & S!rnnEE;I StmngE bt !Suong[ v—[Sl.rmg L V] Stmng-[ V1Suonjt ;[Hes:shve V|
o gijoo _@hoo  @hoo  ofio0 sl shioo sfioo g0 2 g
I O R ) ] [' [ 1'? [ I
sl L dul Dulpml.vltll.tpuLLv;ﬂutmeV|DulpuLV|EluputLV]UutpulLv|
OFF OFF OFF ON oM oM ON (]} 0N OFF
OFF OFF 0OFF aM [ oM aM oK | OFF

9. Experiment with other materials such as plastic and wood or overlay used for your product.
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6.1 CY3218-CAPEXP1 Kit Schematic
The schematic for the CY3218-CAPEXP1 CapSense Express Evaluation Kit is available on the kit
CD/DVD:
m PDF file: <CD_root>\Hardware\REF_14695 REVSA Schematic.pdf
m DSN file: <CD_root>\Hardware\REF_14695 REVSA.dsn
6.1.1 Schematic Page 1
VCC_3Vv3
9 L1
1 VCC 0.9V 1.5V 1 Y Y \L2
I\
N—] 2.2 uH, 4018
Battery Clip AAA R2
u1
R4 H 100K 1% R1
R3 [a]
S4K 1% ‘9‘ vIN L R5 160 1%
5:103 uFd16;/ | S En vour |2 i seoK
| Cs | c4
8 ——10uFd16v  —=—10uFd 16v

R6
249K 1% J2

:.1
¥

100K 1%
HEADER 2 SMD

D1
LED RED

R8
100K 1%

Boost Regulator, 0.9V to 1.5V Input, 3.3V, 200mA Output
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6.1.2 Schematic Page 2

csint VCC 3v3 VCC_3v3
D2 R35
Cc7 | Keypad BKLight 1 {1 e 2
cs co Glo| ciiptacis cia cis Cis "%
“I" No Load 0603
F1 uFd"'"’FJ uFd““FA uF%’ 1 uF%.m u%m u%m u%m u%jﬂ uF LED GREEN RMNT 68
=4 D3 R36
=
= Keypad BKLight 3 1 . 2
£ (4
Decap for CapSense
optional H Paproas LED GREENRMNT 68
Capacitor to &
: pul D4 R32
improve SNR E]
g Keypad BKLight 2 4 . 2
(4
LED GREEN RMNT 68
S|
k=
=
o | vecavs
e 8 g q Keypad Backlight LEDs, Green
w
4
= = = o
S 5 20
% © % > Cap_Button_1
LED1 4] | 12 Cap Bution 1 —" /CC
LED 1 aPol0] apofz |-12-Cao Button | VCC 3V3
Keypad BKLight 32 XRES_PSOC XRES_PSOC D8 R9
GPO[1] XRES J sutton 2 LED 1 ¢
ap_Button_:
12C_SCL 12 scL 12C SCL GP1[4] _mﬁm_?oc Button 3 s
ap_Button LED GREEN RMNT 68
12C_SDA 12C_SDA 12C SDA Gpi[a) |2—CapButlon 3
S = [
Tz 93 D7 R10
A LED 3 K
s
BN CY8C20110 QFN16 LED GREEN BMNT 68
g g =
g g D8 R11
LED 2
31y - 4
[a)
3 3 8 LED GREEN RMNT 68
Status LEDs, Green
CapSense Express
VCC 3v3
c6
“T 0.1uFd R13 R15
J5 VCC 3V3
| = :S NOLOAD ;S NOLOAD
2 XRES
$ c17
R16 . s _A330 _[2C SCL
5 12C_scL =T No Load 0603 R101
HDR 7x5 RA XRES_PSOC XRES
| R12 330 12C SDA <
12C_SDA R100
= XRES_PSOC NO LOAD
NO LOAD
I2C Interface
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6.1.4 Schematic Page 4

VCC_3V3
Cap_Button_1 Cap_Button 1 _R19 ' 560 Button 1
l R33
.S 10K
_ S )
Mech_Button o Oiﬂ:'—.c 1
Cap_Button_3 Cap_Button 3 R18 560 Button_3 Mech Bufion
R41 Dome Switch

100K 1%

Cap_Button_2 Cap Button 2 R20 560 Button 2

Mechanical Button

CSB3 CsSB2
M@ %@
CapSense CapSense
CsB1
Button_1 1 é é)
CapSense

CapSense Rectangular Buttons
with Curved Edges
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6.2 CY3218-CAPEXP1 Board Layout

— .

== CYPRESS

The board layout for the CY3218-CAPEXP1 CapSense Express Evaluation Kit is available on the kit

CD/DVD:

m PDF file: <CD_root>\Hardware\PDCR_9458 REVSS Layout.pdf
m Board file: <CD_root>\Hardware\PDCR_9458 REVSS.brd

m Gerber file: <CD_root>\Hardware\PDCR_9458 REVSS.zip

6.2.1  PDCR-9458 Top Layer

———

44
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6.2.2 PDCR-9458 Bottom Layer

XX

e
KRLRRRLK] @
L POCR 9458 XN oAl

6.2.3 PDCR-9458 Top Silk Screen

GPO[0] GPO[3] GP1[2]
D6 D8 D7
K K M
GPO[2] GP1[4] GP1[3]
S1
GPO[4]
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6.2.4 PDCR-9458 Bottom Silk Screen

=& CYPRESS CY3218-CAPEXP1
CapSense Express Evaluation Board
J1
+
AAA BATTERY
R2 L POWER 1 C15
1© Ct R1 D1 1 C16 J5
o |1 C14 ¢c7 ce -
J2 — n ;] 1 C13 “esint 7y A
- Icle R12 | GND
u1 a—o_ | C11Ug Rz | =
w | c10 R13 | N
R3 R4 co | R1s |
I~ 1 I R5 C81 | scL
(I I R8 R16 o
R6R7 —— __ __ _ shAG
o o 00 W o s
—— =N - © o
R100 i
| S5
cLt7 1 1 R35 @
D3 R36 D4 _ D2
|
6PO[1] GPL[1] [ ] R32 GPl[D][ ]
hv4 hv4 hv4
R41—
R33 -
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6.3 CY3218-CAPEXPL1 Bill of Material (BOM)
The BOM for the CY3218-CAPEXP1 CapSense Express Evaluation Kit is available on the kit CD/
DVD as an Excel file: <CD_root>\Hardware\121R_ 45800 REVSS BOM.xls
Item | Qty Reference Part Manufacturer Mfr. Part#
1 3 |csB1,cSB2,CSB3 CapSense Button Rect Solid zﬂea;r;“facmr'”g pro-
2 3 C1,C3,C4 CAP CERAMIC 10.0UF 16V X5R 1206 Kemet C1206C106K4PACTU
3 6 C2,C6,C8,C9,C10,C11 CAP .10UF 10V CERAMIC X7R 0603 Kemet C0603C104K8RACTU
4 2 C7,C17 CAP NO LOAD 0603 NA NA
5 8 C12,C13,C14,C15,C16 CAP .10UF 10V CERAMIC X7R 0603 Kemet CO603C104K8RACTU
6 1 |b1 LED RED CLEAR 0603 SMD Lite-On Trading USA. |, 151_c190cKT

Inc.

3 D2,D3,D4, D6, D7, D8 LED GREEN CLEAR 1206 REV MT SMD LITE-ON INC LTST-C230KGKT
D6, D7, D8 LED GREEN CLEAR 1206 SMD LITE-ON INC LTST-C150GKT
1 Jl CLIP BATTERY AAA/N .375X.460" SS Keystone Electronics |55
10 |1 |2 CONN HEADER 2POS .100" VERT 15AU rfgr:?é‘slvgz'ﬁ)om Blec- 1683011055
11 1 J5 CONN HEADER 5P0OS 0.1 RA KEYED Molex 22-05-3051
12 1 L1 INDUCTOR 2.2UH 1.44A 20% 1607 SMD Taiyo Yuden / Kemet [NR4018T2R2M
13 1 R1 RES 160 OHM 1/10W 1% 0603 SMD Yageo RC0603FR-07160RL
14 4 R2,R7,R8,R41 RES CHIP 100K OHM 1/10W 1% 0603 SMD |Yageo RCO0603FR-07100KL
15 1 R3 RES 549K OHM 1/10W 1% 0603 SMD Yageo RCO0603FR-07549KL
16 5 R4,R13,R15,R100,R101 RES NO LOAD 0603 SMD NA NA
17 1 R5 RES 560K OHM 1/10W 1% 0603 SMD Yageo RC0603FR-07560KL
18 1 R6 RES 249K OHM 1/10W 1% 0603 SMD Panasonic - ECG ERJ-3EKF2493V
19 6 R9,R10,R11,R32,R35,R36 |RES 68 OHM 1/16W 5% 0603 SMD Panasonic - ECG ERJ-3GEYJ680V
20 2 R12,R16 RES 330 OHM 1/16W 5% 0603 SMD Panasonic - ECG ERJ-3GEYJ331V
21 3 R18,R19,R20 RES 560 OHM 1/10W 5% 0603 SMD Panasonic - ECG ERJ-3GEYJ561V
22 1 R33 RES 10K OHM 1/16W 5% 0603 SMD Panasonic - ECG ERJ-3GEYJ103V
23 1 S1 a\i\ggﬂj\{fg;gﬁ?\;;'20MMX7'20MM E-Switch TL6120AF160QG
24 1 Ul Il%ssgsc BOOST CONV 1.3A SW ADJ Texas Instruments TPS61200DRCT
25 1 u2 nanoPSoC - Capsense Lite Family 16-QFN Cypress Semicon- CY8C20110-LDX2I

ductor

Special Jumper Installation Instructions

Sullins Electronics

26 1 Install jumper across pins of J2 Corp STCO02SYAN

Special Standoff Installation Instructions

27 4 Install standoffs with screws through holes on |Keystone Electronics |24395
corners such that they hold the battery termi-

28 4 nals (on the bottom of the board) off the table- | Keystone Electronics |29311

top.
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6.4 CY3218-CAPEXP1 Pin Assignment
Pin Number Port Number Design Function
GPOI[0] LED_1 (D6)

2 GPO[1] Keypad_BKLight_3 (D3)

3 I12C SCL I12C_Clock

4 12C SDA I12C_Data

5 GP1[0] Keypad_BKLight_1 (D2)

6 GP1[1] Keypad_BKLight_2 (D4)

7 VSS Ground connection

8 GP1[2] LED_3 (D7)

9 GP1[3] Cap_Button_3

10 GP1[4] Cap_Button_2

11 XRES Active HIGH external reset with internal pull down

12 GPO[2] Cap_Button_1

13 VDD Supply voltage (3.3 V)

14 GPO[3] LED_2 (D8)

15 CSint Integrating capacitor input

16 GPO[4] Mechanical button
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